S

© 2002 All rights reserved

Chameleon WEMUS51 for USP-51
(8051 Family Emulator)
Installation Instructions

SWII-ChamUSP-51 2.22.02.13.05

PURPOSE: This document describes the Chameleon WEMUS1 debugger installation process for use
with the Signum Systems USP-51 emulator for the 8051 family of microcontrollers.

1. Insert the Development Tools for Microsoft Windows CD into your CD-ROM drive. InMaster
Setupwindow, selecChameleon Debuggerand double-clickUJSP-51 ICE

gHastEI Setup = E3

[El- Chamneleon Debugger

- USP-36 ICE [wer 2.02.01)

- USP-188 ICE [wer 2.98.05]

- USP-Z8 ICE [ver 2.87.00)

- |nfineot Tricore for JOSnet & wiggler [ver 2.98.06]
- BRM for JOSnet [ver 2.98.08)

- TMS 320 C2ux for JOSnet [ver 2.38.08)

- TMS 320 C3xAC33 for JDSnet [ver 2.98.08)

- TMS320 Chx For JDSnet [wer 2.90.00)

5} 77027114 - TMS 3201 C54 far JDSnet fer 2.90.00)
g . JDSnet-2uLP JTAG ICE [ver 2.98.08]

- TMS 320 T2 for ¥DS510/EVM [ver 2.98.06]
5',-] slems . TMS 320 C3AVC33 for XDSE10 [ver 2.98.08)

- TMS320 T8« for XDS510/EWHM [wer 2.90.00)
- TS 320 C54x for %DS510/EWM [wer 2.90.00]
H- lceServer - remote access to emulators
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Signum Systems Chameleon WEMUS51 for USP-51 — Installation Instructions

2. If you are running Windows XP/2000/NT and intend to use the parallel port, please ‘$ekeict the
following dialog box to provide Chameleon Debugger with the necessary parallel port driver.

Question

@ Concems USPAIDS units with activated parallel port:

Ta inztall the ICE's parallel part driver
the cument account should be assigned
the administratar privilege level

Thiz iz necesszary for the setup program o add

a registry entry required by the ICE parallel port driver.
IF wou ingtall the debugger from an account

without the administrator privileges

the debugger will not work, with the ICE parallel port,

Would pou like to install the parallel port driver now?

3. Complete the Chameleon WEMUS51 debugger installation process.

4. Connect the USP-51 emulator to your computer through either a serial port (e.g., COM1), or parallel
port (e.g., LPT1), and connect it to the power supply. Plug the power supply cord into an outlet and
connect the emulator to the POD using the two white flexible cables that extend from the front. Make
sure that everything is connected properly and turn the emulatdd@mot connect the POD to the
user target yet. Please complete the installation procedures described below first.

5. Start WEMUS1. The program is in the Windows' Start menu under Programs | Signum Systems
WEMU-51. If you installed the Chameleon WEMUS51 for the first tifddEMUS1 Project Manager
dialog box appears.

B WEMUS1 Project Manager E

Mo information about recent projects waz found in the master project
configuration file.

IF you wiould like to create new praject now [recommended), click Create
e

Click Open ta browsze for already existing project file and open the praject.
If you click Cancel you may create new project or open existing project
later frarm PROJECT menu.

Cronte Now Open.. | Cancel |

In order to begin working with the emulator you have to create a new project. The fastest way to create
new project is by clicking th&€reate Newbutton in the dialog box. This launch@&soject Creation
Wizard.

If you click on the Cancel button, the dialog box disappears, and the debugger menus become
available. Most of the menus are disabled when no project is opened. HowevetHeligandProject
submenus are still available to allow you to read program documentétiglp { Contents), obtain the
program version numbeHglp | About) or create a new projecP¢oject | Create New).

Click on theOpen dialog box button if you just reinstalled the debugger, but earlier created a project
with a previous Chameleon WEMUS51 version. This brings up the standard WinOpessdialog box.
Browse for a project configuration file Wemu51.CNF located in your project directory. Select
Wemu51.CNF to open the corresponding project.
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Signum Systems Chameleon WEMUS51 for USP-51 — Installation Instructions

A brand new project is created by launchiRgoject Creation Wizard from the WEMUS51Project
Manager dialog box. Press théreate Newbutton or selec€Create Newfrom theFile menu:

Project Creation Wizard

Welcome to the Create Project
VWizard

Thig wizard helpz you create project that will be
uzed by the Chameleon debugger to save and
mahage all your programs, data and zettings.

To continue, click Mest.

< Bach Cancel |

Click on theNext wizard button to begin creating a new project. You will be asked to type project
name and optional comment text:

Project Creation Wizard

Flease select name and optional comment far
your project,

The project name may conzist up to 32 chars and
iz dizplayed on debugger's title bar when a project
iz opened.

The comment iz optional and usually is a brief [up
ta 256 charz] description of project features. [t
may be left blank now and zet later from
FROJECT-:INFORMATION men.

MHame:

ITest Froject

Comment [optional):

Thiz iz a test project ;I
-]

¢ Back I Mest » I Cancel |
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Click on theNext button. In this step, you are asked to select the project directory, one in which all
project related files will reside. These files include your application executable file, source code files,
the project command startup file Wemu51.INI, definitions of custom toolbar buttons and the like.

Project Creation Wizard E

Flease select project directony for vour project.

Project directory iz a folder for files and subfolders
where all project files will be ztored.

Main project settings will be stored in the project
configuration file "wERMUST.CHMF" located in the
project directory.

Other files stored in the project directory will be:

- project command startup file "WERMUIST NI,

- program executable and source code files,

- definitions of custom toolbar buttons,

- wanous project related data filez,

Mate, that project directary has to have file create
and wirite rights.

YWe strongly recommend to avoid use of
debugger's installation directory "C:A\Program
FileshSignum Syatemsiw/emubl" as a project
directory |

IF:'\Signum\WemuE'I FrojectshTest Project 1

Erowse...l
< Back I Mest » I Cancel |

In the next step, you are asked to choose the target for your project. Select USP-51 In-Circuit Emulator
in order to work with the Signum Systems emulator, as shown in the illustration:

Project Creation Wizard

Flease select target you want ta uze in
your project from the following lizt of
avallable targets.

-51 In-Cir

& 3
(Sl SirnLlatar

¢ Back I Mest » I Cancel
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In the next step, select the communication device (e.g., host computer communication port) to connect
the selected target device (the USP-51 emulator) with the host computeDé&theted Devicedist

box shows the available computer ports that can be used to establish the connection. Select the proper
port (the same as in step 4 above) — or IceSérnfgou connected the emulator to the network — and

set the remaining parameters. When using a serial port or IceServer, for best performance, select the
highest baud rate, 57600 bps. When you use the parallel port and your computer is running Windows
ME, 98 or 95, you need to select a base LPT port address. Please obtain that address using Device
Manager available from the Control Panel System dialog box. Windows XP, 2000 and NT provide this
address automatically; the address cannot be modified and is grayed out, as shown below.

Project Creation Wizard

Flease select communication device far your
project from the following list of detected devices.

Detected Devices: LPT Port Address:

0x378
A COMI
¥ com2
B2 |ceServer

= leeSenven host:

I ame o P addiess: I
NI port: I

< Back I Mest > I Catcel

! lceserveris Signum's optional driver enabling the emulator to be operated remotely over a network.
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In the next step, you will be asked to select processor you use in your project. From the list of available
devices, select the processor whose name corresponds to the processor chip located on the POD
connected to the USP-51 emulator via two wide flexible cables, as shown in the illustration below.

Project Creation Wizard E

Flease select processor you want to uge in pour
project fron the fallowing list of processars.

If pou cannat find exact processar name pleaze
zelect proceszor manufactured by the zame
company which has features most alike to vour
processor of contact Signun Systems Techiical
Support for an assistance.

Atmel WG B9CETIC2 A
Atmel YWl B9C51RE2

Atmel Whut 89C5IRC2
LAtme| WAl S9CR1BD 2
Dallas BEB0CH 0
Diallas DS80C320 =

CPL with 32/481/0 lines, High-5peed
rehitecture, Clack 22 function, Dual DPTR,
DT. FCA with P/, Compare/Capture and
HS0O, 3 Timers/Counters, 7 Intermupts with 4
pricrity levels, B4K Flazh, 256 Botes |RAM,
additional configurable TK. on-chip <Rabk, 2K
EEPROM uzed as XDATA

< Back I Mest » I Cancel |

Clicking on theNext button brings up the last wizard dialog box that summarizes the choices you have
made so far. If you want to modify some of these settings, pres®#uk, go to the appriopriate
wizard dialog box, make the desired changes, and then return to the last dialog box. Verify that the
Open new project after it is createdcheck box is checked. Eventually, click on tRimish button to

exit wizard and create your new project using the selected parameters.

6. Chameleon WEMUS51 debugger opens the project you have created, establishes communication with
the USP-51 emulator (selected target), and then disi8alect Clock and Power Settingslialog box.
Please select the processor power sour@xssnal (i.e., from your target board) when the emulator’s
POD is plugged into your target board. The source shoulohteenal (i.e., from the emulator), when
the POD is the so-called standalone mode, that is, not connected to any target board.

Select the processor clock sourceeagernal or internal when the emulator’s POD is plugged into
your target board, ointernal (from the POD), when the POD is unplugged from your target board.
Choose the appropriate clock frequency and clock speed rate — x2 for new chips from Atmel W&uC,
Philips or another brand if you plan to use this processor feature; x1 otherwise). The effective
processor frequency is calculated as the selected frequency multiplied by the speed rate.

IMPORTANT NOTE: The clock frequency selected in the dialog box does not set the frequency of the
processor clock located on the POD or on your target board. This value is simply used by the debugger
when timing data have to be calculated.

B Select Clock and Power Settings E
Proceszar Power Proceszor Clack [MHz]
" Internal & Intermal |3

0.0
speed rate: % |1
ED I_

Cancel |

pury

* External " Extemnal
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7. After the project is opened, the debugger displays the initial window layout with Status, Source,
Symbol Explorer and Command windows opened. Please note that the names of the selected target
(Emulatop) and project Test Project are displayed on the debugger’s title bar. The screen should now
look like this.

%' Signum Systems WEMUS1 - Emulator: “Test Froject™
File Edit “iew Debug Project Options ‘window Help

] thective EIEEIRE]
[R/Source_1 M =] E3 |} 'k Command 1 =M CE Status_1 =] E3
or  0000: 120794  LCALL 0794 | Mem=Program State: STOP
0003: 900075 MOV DPTR,#D:I IS PIEIEREIN
0006 : Ed4 CLR & ¥ 1 PC = 0000
o0o07: Fo HOVE @DETR. A Chameleon dsbugger EANK = 0
008: A3 INC DPTR Version 2.03.00 g
ooo09: FO HOVE @DETR, A Copyright @ Signum Systems Corp. 1995-2002  DPTR = 0000
000&: 900052 WOV DPTR, #01 ] ]
oooD: 7401 HOW AL #01 89C51RDZ In-Circuit Emulator A=00 SP=07
000F: FD HOVE @DETE. A ) . E=00 IE=40
001l0: 741E HOW A tlE Executing startup command file WEMUS1 INI:
0012: A3 INC DPTR >
0013: ED HOVE @DPTR.4 nap Program All Iee RegBank=0
0014: A3 INC  DETR Frogram Memory:
0015: 7400 MOV A #00 | ——oo————oo T RO=00 Ri=00
0017: E0 HOVE @DPTR. 4 0000 — FFFF ICE R2=00 R2=00
n0ie: 7452 HOV & #52 R4=00 RG=00
0014: A3 INC  DETR External Data Memory: R&=00 R7=00
001E: FD HOVE  @DPTR. A
n0ic: 900073 MOV DPETR. #i1 EUDD idFEFF Igl " Clock: Int
Tap ata =8r Power: Int
R SymbolExplorer_1 Progran Memory: Trace. Enpty
I j . I ——— Ewvent :
0000 — FFFF ICE Counter:
All Symbols |CPU Define Sequencer Of f
7] & Spmbals Name Exzternal Data Memory: ]
CPU Defined Symbolz @ AC 0000 — FFFF User RunPC = 0166
User Defined Symbols & ACC ¥
1= Program Defined Symbolz & AlxR ‘l | LA [
& AlLXAT TEZ TFR uchar
@B 0aFo SFR uchar
& CCAPOH 00FA, SFR uchar
& CCAPIL O0EA, SFR uchar
& CCAPTH 00FE SFR uchar
& CCAPIL 00ER SFR uchar

The File menu can be used to select and load your application and to open or save various data
from/into files.

The View menu allows you to open various debugger windows, like Status or Command (which are
already opened).

The Debug menu allows you to start, stop and step through loaded application as well as set/clear
breakpoints.

The Project menu facilitates project management tasks. Use it to create new projects, list and open
existing projects, close the current project and modify the current project settings.

The Options menu allows you to change the project target and communication device as well as to
customize toolbars.

TheHelp menu allows you to open the debugger documentation (Help | Contents), obtain the debugger
version information (Help | About); launch an Internet browser with the Signum Systems WEB site
opened (for example, to check for the latest software upgrades); or even to open an e-mail client
software to send a message to the Signum Systems support personnel, if necessary.
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8. Turn the entire system off and connect the POD to the target board.

NOTE: If you would like to explore the program before connecting to the target board, proceed as
follows.

In the Command window on the right side of your screen, you should see a record of the
WEMUSL1.ini file commands that have been executed when the project was opened. (This project
startup command file contains the commands executed automatically upon opening the project). Note
that memory has been mapped so that the memory on the target board is used and the POD is ready for
development and debugging of the target board. However, if you choose to explore and experiment
with the program before you connect it to the target board, you need to remap the memory so that the
emulator's memory is used instead. To accomplish that, typap“ P all | ” (map the entire
program memory to the emulator) in t@mmand window and hit theEnter key. Then type fhap

X all 1 7, which will place the external memory data in the emulator's memory.

ﬁ Command_1 M=l E
Mem=Frogram

FProgram Memory: ﬂ

0000 — FFFF ICE

External Data Hemory:

0000 — FFFF TUser
>

¥
smap P oall I -J
Program Hemory:

o000 — FFEFF ICE

External Data Hemory:

0000 — FFFF User
rmap % all 1
Program Memory:

0000 — FFEFF ICE

External Data Hemory:

0000 — FFFF ICE

>
KN H oz
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